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1 Úvod

Tento dokument má za úkol provést neznalého uživatele instalaćı publikačńıho systému TEX
s nadstavbou LATEX a ukázat několik základńıch prvk̊u psańı technické dokumentace. Byl vy-
tvořen na základě potřeby student̊u předmětu Moderńı teorie ř́ızeńı [1] publikovat práce
v náležitém formátu bez větš́ı znalosti problematiky. Veškerý popsaný software je zdarma ke
stažeńı, je licencován GNU licenćı [2], nebo je maximálně nutná registrace uživatele.
V sekci 2 poṕı̌seme postup instalace potřebného software a jeho nastaveńı. Naistalujeme

základńı utility , jádroMiKTeX a prostřed́ı pro editaci text̊u TeXnicCenter. V sekci 3 pro-
vedeme test správné instalace a pokuśıme se napravit př́ıpadné chyby. V sekci 4 poṕı̌seme
software pro psańı rovnic TeXaide. Sekce 5 ukáže práci s obrázky a možný software pro kres-
leńı vektrové grafiky PageDraw. Nakonec v sekci 6 přidáme několik př́ıklad̊u psańı z praxe.

2 MiKTeX a potřebné utility

2.1 Adobe Arobat reader

http://www.adobe.com/products/acrobat/readermain.html [13MB]
Je to software na prohĺıžeńı a tisk PDF dokument̊u. Pokud čtete tento dokument v elektronické
podobě, je již na Vašem PC nainstalován.

2.2 GhostScript a GSview

http://www.cs.wisc.edu/˜ghost/index.html [8MB+1.5MB]
Je to software nutný k prohĺıžeńı a tisku PS dokument̊u, také je ke generováńı font̊u pro
vestavěný prohĺıžeč MikTeXu.

2.3 MiKTeX

Kdo již má předpřipravenou distribuci, může krok Download vynechat.

2.3.1 Download

http://www.miktex.org [setup 0,5MB;20-150MB]
Toto je pouze instalátor, s jehož pomoćı stáhnete baĺıčky distribuce LATEXu.
Návod pro download:

1. Spust́ıme stažený instalátor.

2. Volba Download only - jen stáhnete baĺıčky na lokálńı disk.

3. Volte velikost distribuce Large. MiKTeX 2.4 umı́ stáhnout a naistalovat potřebné baĺıčky
za běhu, proto na PC s internetem postač́ı distribuce Small.

4. Dále volte FTP, ze kterého se budou baĺıčky stahovat. Nejlépe nějaký v Česku.

5. Složku baĺıčk̊u volte libovolně.

http://www.adobe.com/products/acrobat/readermain.html
http://www.cs.wisc.edu/~ghost/index.html
http://www.miktex.org
roubal
Lístek s poznámkou
GhostScript již není v nových verzích MiKTeXu nutné instalovat (je součástí instalace MiKTeXu)

GhostScript neinstalovat do C:\Program Files\gs ale např. do C:\Programs\gs
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Obrázek 1: Instalačńı program MiKTeXu

2.3.2 Instalace

Předpokladem je, že máte složku baĺıčk̊u někde na lokálńım PC.
Návod instalace:

1. Spust́ıme instalátor.

2. Volte Install.

3. Volte velikost distribuce Small.

4. Zadejte složku baĺıčk̊u.

5. Nainstalujte vše do adresáře c:\texmf.

6. V Create LocalTEXMF tree volte c:\localtexmf.

7. Don’t incorporate existing TEXMF tree.

2.3.3 Konfigurace

V nab́ıdce Windows Start spust’te MiKTeX → MiKTeX Options.

roubal
Lístek s poznámkou
NEINSTALOVAT DO PROGRAM FILES a podobných adresářů s mezerami, českými znaky apod.

Pokud instalujete verzi ze školy (tj. MiKTeX 2.3), nastavte při instalaci a prvním překladu na PC rok 2005.
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Obrázek 2: MiKTeX Options

V záložce Languages vyberte jazyk czech pro správné děleńı slov a odškrtněte ostatńı
jazyky. Zmáčkněte OK a nelekněte se několika chybových hlášek, které jsou z d̊uvodu Small
instalace, protože některé součásti chyb́ı, ale my je nepotřebujeme. Ostatńı potřebné baĺıčky se
instaluj́ı automaticky při prvńım použit́ı.

2.4 TeXnicCenter editor

http://www.toolscenter.org/products/texniccenter/download.htm [4,5MB]
Toto vývojové prostřed́ı zjednodušuje práci s editováńım zdrojových text̊u a obsahuje skripty
pro překlad dokument̊u do r̊uzných formát̊u. Základńı vlastnosti má podobné všem běžným
textovým editor̊um.
Při instalaci zvolte typickou konfiguraci. Po prvńım spuštěńı tohoto programu v nab́ıdce

Start proved’te základńı nastaveńı. Budete dotazováni na umı́stěńı hlavńıch spouštěćıch pro-
gramů MiKTeXu, které jsou v direktoráři c:\texmf\miktex\bin. Pod Windows XP preferujte
volbu Use with MiKTeX. Vytvořili se tři překladové profily s výstupem do DVI, PDF a PS.

2.5 WinEdt editor

http://www.winedt.com [trial 4,5MB]
Jedná se o nejpouž́ıvaněǰśı, ale bohužel komerčńı software. Je alternativou k TeXnicCenter.

http://www.toolscenter.org/products/texniccenter/download.htm
http://www.winedt.com
nsxhitman
Lístek s poznámkou
Doporučuji spíše používat WinEdt.

Odkaz změněn na :
http://www.texniccenter.org/resources/downloads/

nsxhitman
Lístek s poznámkou
V nové verzi nelze angličtina odškrtnout, můžete klidně ponechat.

Jirka
Lístek s poznámkou
Doporučuji používat tento editor. Ve škole je verze 5.3.

V něm je třeba pro správné zobrazování českých znaků nastavit správný font: Menu - Options - Fonts - Courier CE.

Také lze nastavit slovník: Menu - Options - Dictionary...

Jirka
Lístek s poznámkou
Po první překladu TeXify (Ctrl-Shift-X) se otevře prohlížeč DVI souborů YAP. 

V nových verzích MiKTeXu někdy hodí chybu. V menu View - Options - Display změňte Default render method na DVIps. 

Také doporučuji nastavit v menu View - Options - Inverse Search příslušný editor (WinEdt).

Dále nastavte Wrapping. V menu Options - Configuration Wizard - Wrapping označte "Use Conventional Wrapping" a odznačte ostatní možnosti. Poté restartujte WinEdt.



3 TEST SPRÁVNÉ INSTALACE 4

3 Test správné instalace

Do editovaćıho okna TeXnicCenter napǐste a uložte do nějakého souboru tento text:

\documentclass{article}
\usepackage[czech]{babel}
\usepackage[cp1250]{inputenc}
\begin{document}
Můj prvnı́ dokument v~\LaTeX u.
\end{document}

Na obrázku 3 jsou vyznačená potřebná tlač́ıtka a informačńı okno překladače. Vyberte profil
LaTeX=>PDF a zmáčkněte ikonu Překlad.

Obrázek 3: TeXnicCenter

Během prvńıho spuštěńı budete dotazováni na instalaci baĺıčk̊u, hlavně csfonts. Odsouhlaste
vše.
Pokud vše proběhlo a máte výstup v okně Info stejný jako na obr.3, je vše v pořádku.

Pokud ne, chyb́ı některé baĺıčky a muśıte je nainstalovat ručně, což je popsáno v podsekci 3.1.
Výsledný dokument je možné prohlédnout zmáčknut́ım ikony Zobrazeńı. Prohlédněte si

ṕısmo, a pokud bude nepěkné postupujte dle návodu v podsekci 3.2. Vyzkoušejte přeložit
a zobrazit pomoćı daľśıch profil̊u.

3.1 Ručńı přidáńı baĺıčk̊u

MiKTeX 2.4 umı́ stáhnout a naistalovat potřebné baĺıčky za běhu v př́ıpadě potřeby, ale
tato funkce má problémy s Windows 98. Proto je někdy nutné naistalovat baĺıčky ručně.

Jirka
Lístek s poznámkou
Dále není třeba studovat tento dokument. Stačí pozorně pracovat s předpřipravenými šablonami.
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1. Otevřte MiKTeX → MiKTeX Options, záložku Packages.

2. Zvolte v okně Download Site adresář s instalačńımi baĺıčky MiKTeXu, nebo na PC
s internetem vzdálený server s baĺıčky.

3. V seznamu zaškrtněte baĺıček Languages → Czech/Slovak→ csfonts.

4. Také Formats → LaTeX → Basic LaTeX → geometry.

5. Ještě Formats → LaTeX → LaTeX Packages → picins, což je styl pro obtékané obrázky.

6. Zmáčkněte OK.

7. Proved’te znovu překlad dokumentu.

3.2 České fonty

Pokud je ṕısmo v PDF dokumentu kostrbaté, muśıte ručně zvolit použit́ı csfonts.

1. Pomoćı TeXnicCenter editoru otevřte soubor c:\texmf\pdftex\config\pdftex.cfg.

2. Přidejte do něj řádek map +csfonts.map.

3. Dokument znovu přeložte a zobrazte.

4 TeXaide pro psańı rovnic

http://www.dessci.com/en/products/texaide/ [1MB, registrace]
Je to jednoduchý editor rovnic s možnost́ı př́ımého koṕırováńı do zdrojového textu dokumentu.

Obrázek 4: TeXaide

Pro nastaveńı zaškrtněte Format→Inline Equation a v Edit→Translators... zrušte
Include MathType. Použit́ı je jednoduché: napǐste rovnici, označte myš́ı, zmáčkněte CTRL+C a
v textu CTRL+V. Dostanete $l = \sqrt {x^2 + y^2}$ což se přelož́ı jako l =

√
x2 + y2.

Časem zjist́ıte, že zp̊usob zápisu rovnic ve zdrojovém textu neńı nijak složitý a TeXaide
budete využ́ıvat jen minimálně.

http://www.dessci.com/en/products/texaide/
nsxhitman
Lístek s poznámkou
TeXaide se změnil na MathType (Trial). 
Odkaz zde :
http://www.dessci.com/en/products/mathtype/default.html

Program TeXaide je zdarma.
Odkaz zde :
http://sunsite.bilkent.edu.tr/pub/tex/ctan/support/texaide/

Po instalaci TeXaide nastavte: Menu Edit - Translators: Translator: TeX -- LaTeX 2.09 and later
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5 Obrázky a PageDraw

Základńı formát pro obrázky je EPS. Ten neńı v PdfTEXu podporován, tam je základńım
formátem PDF a dále jsou podporovány TIF, JPG a PNG. EPS obrázky, které chceme použ́ıt
v PdfTEXu, muśıme převést na PDF pomoćı nějaké utility, např. popsaná v sekci 5.1. PdfTEX
je stále ve vývoji, tak je jen otázkou času, kdy budou podporovány všechny formáty obrázk̊u.
Je dobré kreslit vektorovým softwarem, protože výsledný soubor je menš́ı a při zvětšováńı se
neděĺı na pixely. Vhodný vektorový software je popsán v sekci 5.2.
Obrázek z Matlabu źıskáte ve formátu EPS pomoćı File→Export... .

5.1 ImageMagick

http://www.imagemagick.org[6,5MB]
Jedná se o vhodný software na konverzi všemožných formát̊u obrázk̊u. Po instalaci je použit́ı
jednoduché. V př́ıkazovém řádku spust’te convert zdroj.eps cil.pdf. Př́ıpona souboru určuje
zdrojový a ćılový formát.

5.2 PageDraw

http://www.mayura.com[0,5MB]
Je to software pro kresleńı vektorové grafiky. Buhužel jeho posledńı verze Mayura Draw, která
je dle mého názoru asi nejlepš́ı svého druhu, neńı zdarma. Ale můžete stáhnout a nainstalovat
starš́ı verzi, která má méně funkćı a nastaveńı vkládáńı text̊u je tam trochu složitěǰśı.
Instalace font̊u pro PageDraw 2.04:

1. Nainstalujte Adobe Type Manager Light.
http://www.adobe.com/products/atmlight/main.html[12MB]

2. V jeho konfiguraci vyberte některé fonty z c:\texmf\fonts\type1\urw a zmáčkněte
Add. Doporučuji přidat curier a symbol. Tyto fonty nepodporuj́ı české znaky.

3. Pak v PageDraw je možno vkládat text.

Po nakresleńı obrázku źıskáte EPS soubor pomoćı menu File→Export... .

6 Psańı dokumentu

Zde poṕı̌seme zdrojový text dokumentu a ukážeme základńı možnosti psańı technické doku-
mentace. Pro výstup do PDF použijte PdfTEX výběrem překládaćıho profilu LaTeX=>PDF.

6.1 Projekt

Doporučuji použ́ıvat projekty v TeXnicCenter. Vytvoř́ı se v File →New project... . Je
dobré psát ve v́ıce souborech, které jsou pak přidány pomoćı \input{soubor.tex}. Př́ıpadně
pro lepš́ı orientaci si přidat jen právě psanou sekci a ostatńı zakomentovat znakem %. I když
zrovna editujeme jiný než hlavńı soubor, můžeme přeložit celý projekt, a t́ım se při překladu
vyhneme nutnosti přepnout nejdř́ıve na hlavńı soubor.

http://www.imagemagick.org
http://www.mayura.com
http://www.adobe.com/products/atmlight/main.html


6 PSANÍ DOKUMENTU 7

6.2 Hlavńı soubor

Hlavńı soubor vypadá nejčastěji takto:

\documentclass [a4paper,12pt]{article}
\usepackage[top=2.5cm, bottom=2cm, right=2cm, left=2cm]{geometry}
\usepackage[czech]{babel}
\usepackage[cp1250]{inputenc}
\usepackage[pdftex]{graphicx}
\usepackage[colorlinks]{hyperref}
\usepackage{picins}
\usepackage{tabularx}
\usepackage{float}
%----------------------------------------------------------
\begin{document}
\input{nadpis.tex}
\input{abstrakt.tex}
\input{uvod.tex}
\input{rozbor.tex}
\input{experiment.tex}
\input{diskuze.tex}
\input{reference.tex}
\end{document}

Vytvář́ıme tak dokument, který je velikosti A4 s ṕısmem velikosti 12pt typu article (článek)
a definujeme velikost okraj̊u geometry. Pro české názvy obrázk̊u a tabulek použijeme babel
s nastaveńım czech. Budeme psát v kódováńı cp1250. Dále přidáme několik předdefinovaných
styl̊u: graphicx a float pro obrázky, picins pro obtékané obrázky, tabularx pro formátováńı
tabulek a hyperref pro hypertextové odkazy. Můžeme přidat jakékoli daľśı dle potřeby. Základńı
nápovědu o funkćıch źıskáte umı́stěńım kurzoru k názvu funkce a zmáčnut́ım F1. Veškeré styly
a jejich funkce jsou popsány v dokumentaci na c:\texmf\doc\latex.
Zdrojový kód dokumentu se ṕı̌se mezi \begin{document} a \end{document}. V našem

př́ıpadě máme dokument rozdělen do několika soubor̊u na části po jednotlivých sekćıch.

6.3 Psańı textu

Text se ṕı̌se s interpunkćı Windows kódováńım. Ř́ıdićı funkce zač́ınaj́ı znakem \. Základńı
funkce jsou:

• \section{Název\label{sec:nazev}}
Vytvoř́ı nadpis s č́ıslem sekce a návěšt́ım odkazu. Podobně \subsection a \subsubsection
jsou podsekce.

• \indent
Provede odsazeńı na začátku odstavce. Z d̊uvodu kompatibility s jinými národńımi zvyk-
lostmi je nutné občas vynutit odsazeńı pomoćı \indent\indent .

• \\ nebo prázdný řádek
Ukonč́ı odstavec.
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• \textbf{Silné}
Provede tisk Bold fontem. Podobně se dá psát i kurźıvou, v záložkách pod menu editoru
jsou i r̊uzné daľśı ikony, které měńı font označeného textu.

6.4 Program Vlna

ftp://math.feld.cvut.cz/pub/olsak/vlna/ [0,1MB]
Pro správné zalamováńı řádk̊u podle typografické normy se použ́ıvá mı́sto mezery za jed-
noṕısmennými slovy (např. a,v,k,u) znak ˜. To při následném zpracováńı zabráńı zalomit řádek
na nevhodných mı́stech. Program Vlna v zadaném zdrojovém textu takové změny provede
automaticky.
Pro jednodušš́ı práci si ho můžeme přidat jako profil.

1. Stáhněte soubor vlna32.exe a zkoṕırujte do c:\texmf\miktex\bin.

2. V menu TeXnicCenter otevřte Build→Define Output Profiles... .

3. Add a nadpis Vlna.

4. Zašktrněte Run LaTeX in this profile.

5. Do Path napǐste C:\texmf\MiKTeX\bin\vlna32.exe.

6. Do Command napǐste -l %pm

7. Dejte OK.

8. Pro aplikaci každý zdrojový text přeložte s profilem Vlna.

6.5 Reference

• Odkazy na obrázky, tabulky, rovnice a sekce se vkládaj́ı pomoćı \ref{typ:nazev},
kde typ určuje č́ıselnou řadu. Ve výstupu je pak jen č́ıslo odpov́ıdaj́ıćıho objektu. Typ pro
obrázky je fig, pro tabulky tab, rovnice eq a pro sekce sec. Návěst je definována pomoćı
\label{typ:nazev} a umı́st’uje se do textu do mı́sta ćıle odkazu.

• Odkazy do literatury a citace se ṕı̌su pomoci \cite{odkaz}. Seznam literatury
a zdroj̊u se definuje nejjednodušeji v souboru reference.tex takto:

\addcontentsline{toc}{section}{Reference}
\begin{thebibliography}{99}

\bibitem{odkaz} \textsc{Autor} \textit{Název.} SNTL, Praha 1990
\bibitem{odkaz2} \textsc{Autor} \textit{Název.} Skripta ČVUT, Praha 1998

\end{thebibliography}

Jinou možnost́ı je použ́ıt BibTEX , což je nadstavba pro správu citaćı a referenćı.

• Internetové odkazy se ṕı̌sou pomoćı \href{http:\\www.adresa.cz}{Název}.

Při přidáńı referenćı nefunguj́ı odkazy hned, je potřeba v́ıcekrát dokument přeložit aby se
aktualizovaly.

ftp://math.feld.cvut.cz/pub/olsak/vlna/
user
Lístek s poznámkou
Toto používáme my v našich šablonách, viz soubor Styles/Refer.bib.

Když máte ve WinEDT 5.3 otevřený soubor Refer.bib a v nějakém tex souboru napíšete \cite levá složená závorka a pak pravá složená závorka, tj. \cite{}, vyskočí okno Bibliography Items se seznamem odkazů na definovanou literaturu, která je v souboru  Refer.bib. V okně Bibliography Item pak vyberete a entrem potvrdíte nějaký odkaz. Tím se Vám odkaz vloží do daného tex souboru.

Bohužel toto v novější verzi WinEDT nefunguje:-(. Lze to opravit tak, že si v souboru Diplomka.tex na řádku 148 změníte \cestaStyles Refer na Styles/Refer. Po prvním vysázení TeXify (Ctrl-Shift-X) již okno Bibliography Items vyskočí.

Případně si můžete v celém souboru Diplomka.tex nahradit proměnné pro podsložky za skutečné názvy podložek (např. „\cestaFiles “ nahradit na „00_files/“). Definice proměnných je v souboru Diplomka.tex na řádcích 25 – 32.
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6.6 Tabulky

Vytvářej́ı se pomoćı tabular nebo vylepšené verze tabulax.
Př́ıklad:

\begin{table}[H]
\centering
\caption{Název\label{tab:nazev}}
\begin{tabular}{|p{1.2cm}|p{1.2cm}|p{1.2cm}|}
\hline k=1 & k=2 & k=3 \\
\hline 0.4613 & 0.1802 & 0.2002 \\
\hline

\end{tabular}
\end{table}

Sloupce se definuj́ı jejich š́ı̌rkou. Znak | znamená vertikálńı čáru mezi sloupci. Př́ıkaz \hline
nakresĺı horizontálńı čáru mazi řádky. Sloupce jsou odděleny znakem & a řádky znakem \\.

6.7 Rovnice

Rovnice se to textu vkládaj́ı mezi dva znaky $, stejně jak je popsáno v sekci 4. Č́ıslované
rovnice se do textu vkládaj́ı pomoci equation, ale bez počátečńıho a koncového znaku $.
Př́ıklad:

\begin{equation}
\label{eq:rovnice}
l = \sqrt {x^2 + y^2}

\end{equation}

Rovnice (1) z př́ıkladu pak vypadá následovně:

l =
√

x2 + y2 (1)

6.8 Vkládáńı obrázk̊u

Obrázky se vkládaj́ı takto:

\begin{figure}[H]
\begin{center}
\includegraphics[width=5cm]{nazev.pdf}
\caption{Nadpis}
\label{fig:reference}
\end{center}
\end{figure}

Parametr [H] znamená umı́stěńı právě zde a je k němu potřeba styl \usepackage{float}.
Velikost obrázku ve výsledném dokumentu v našem př́ıpadě určujeme jeho š́ı̌rkou a výška se
přizp̊usob́ı ve stejném poměru.
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6.9 Vkládáńı obtékaných obrázk̊u

Zvláštńım př́ıpadem je vkládáńı obtékaného obrázku. K tomu je potřeba styl picins. Nain-
staluje se při prvńım použit́ı inicializace \usepackage{picins}.
Obtékané obrázky se vkládaj́ı takto:

\piccaptionoutside
\piccaption{Název\label{fig:reference}}
\parpic(6cm,5cm)[l]{\includegraphics[width=6cm]{obr.pdf}}

Rozměry za \parpic určuj́ı velikost boxu pro obrázek. Parametr [l] znamená umı́stěńı vlevo,
může být i vpravo použit́ım [r]. Je nutné zkusit několik nastaveńı, než bude výsledek podle
vašich představ.

7 Závěr

Tento dokument je jen základńı ukázkou jak použ́ıvat LATEX pro Windows. Prax́ı určitě
zjist́ıte, že některé věci se daj́ı dělat lépe nebo jednodušeji a časem pochoṕıte i proč se to tak
ṕı̌se. V menu TeXnicCenter je mnoho předdefinovaných pomocných skript̊u, a proto doporučuji
si je vyzkoušet a př́ıpadně se pod́ıvat do manuálu pro popis jejich použit́ı. Veškeré informace
naleznete v adresáři c:\texmf\doc, nebo na internetu http://www.cstug.cz.

Přeji př́ıjemné TEXováńı.
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